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The last article on the Nios V processor covered a basic hello world application running on the MAX
10-10M08 Evaluation Kit. Since Nios V HAL is very big and MAX 10-10M08 Evaluation Kit has
limited memory capacity, the 10M50 Evauation kit will be used moving forward. In this specific
article, we will explore GPI1Os and interrupts with the Nios V.

Please, see the article Altera™ Quartus® Prime Lite v25.1 and Nios® V Install Instructions on
Annabooks.com for information on how to install the Quartus software needed for this hands-on
exercise.

The Project Requirements:

¢ Quartus Prime Lite Edition V25.1, Ashling RiscFree™ IDE, and Nios® V license are already
installed.

o Intel® MAX® 10 - 10M50 Evaluation Kit and the schematic for the evaluation board are
required. The schematic PDF file can be downloaded from the Intel FPGA website.

Note: There are equivalent MAX 10 development and evaluation boards available. These boards
can also be used as the target, but you will have to adjust to the available features on the board.
Please, make sure that you have the board’s schematic files as these will be needed to identify
pins.

The Nios V workflow is different than the Nios Il projects.

o The first step is still the same: creating the hardware design in Quartus Prime and Platform
Builder.

e The second step is to use the Nios V command line to create the BSP and the cmake
project.

e The final step is to write and debug the application with RiscFree IDE.

Note: As of this writing, Altera is still migrating information and licensing details from Intel. You will
see a mix of both company names until the transfer is complete.

1.1 Part 1: Basic Nios V Design

For this design, we will have a Nios V/m processor IP block, along with an onboard RAM IP block,
two GPIO IP blocks, and a JTAG UART IP block. The application will have a button that triggers
an intererupt to toggle the 5 leds on the board. The JTAG interface will be used to send messages
to a console application.

1.1.1 Create the Project
The first step is to create a design project.

1. Open Quartus.
2. Click on the New Project Wizard.
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Hi Home @
Projects Recent Project:
= o & EITDEA Nt Max_
New Project Wizard. G _Max_
WMAX
Directory, Name, Top-Level Entity WhMAX

i-exar
‘What is the working directory for this project? \exan
E:/FPGA/Intel_Max_10MS0_Evaluation_Kit/niosv_gpio
‘What is the name of this project?
Help

niosvgpio

What s the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the
Quartus Prime Handbo ~ design file.

niosvgpio

Use Existing Project Settings

Other Develop

FPGA Al Suite  DSPBL

V| Close page after project

Don't show this screen

Find Next
8 = Help

o

Next > FEinish Cancel

3. Select or create a project directory \niosv_gpio (Do not use the Quartus installation
directory) and name the project: “niosvgpio”. Click Next.

Note: By default, the root directory is the Quartus installation directory. Make sure the root project
directory is a separate path from the Quartus installation files. Also, there can be no spaces in the
name of the folders or projects.

4. Project Type: Empty project, click Next.
5. Add File: no files to add, click Next.
6. Family, Device & Board Settings:
a. Change the Family to “MAX 10(DA/DD/DF/DC/SA/SC/SL)”
b. Put 10M50DAF48416G in the Name filter text box. This should narrow down the
list to a single device.
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@

Family, Device & Board Settings

Device | Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in ‘Available devices' list

Eamily: | MAX 10 [DA/DD/DF/DC/SA/SC/5L)

Package: Any bt
Device: | All - Pin count: Any -
Target device Core speed grade: | Any -
| Auto device selected by the Fitter pamefillec TOMSODAF 484166
®) Specific device selected in ‘Available devices' list v Show advanced devices
|
| Other: nfa
Ayailable devices:
Name Core Voltage LEs Total I/Os GPI10s Memory Bits Embedded multiplier 9-bit el
TOME0DAF48416G 12v 49760 360 360 1677312 288
| 1 »
Help < Back Next > Einish Cancel

7. Select the single available device and click Next.
8. For the EDA tools, clear everything to <<none>>, and click Next.
9. Summary: click Finish.

1.1.2 Create the Design Step 1: Platform Designer

Quartus supports many design types to create an FPGA design. The Platform Designer tool will be
used for this hands-on exercise. Platform Builder makes it easy to add already-built IP blocks and
interconnect them.

1. From the menu, select Tools->Platform Designer, or the Platform Designer icon
from the toolbar.

The Platform Designer tool is launched. By default, a clock (clk_0) is added to the design. Platform
Designer makes it easy to add IP blocks and make interconnections between the blocks.

2. The top left pane contains the IP Catalog with all the available IP blocks that come with
Quartus Prime. In the search box, type nios.
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4 NIOS x| &
Project

.. New Comporent...
Library
[=)-Basic Functions

=2 Simulation; Debug and Verification

: EJ-Simulation

& @ Nios II Custom Instruction Master BFM Intel FPGA IP

“ @ Mios IT Custom Instruction Slave BFM Intel FPGA IP

[=-Processors and Peripherals
E} Co-Processors
. [-Nios II Custom Instructions

- @ Bitewap
Custom Instruction Interconnect
Custom Instruction Master Translator
Custom Instruction Slave Translator
Floating Point Hardware

Floating Point Hardware 2
[ Embedded Processors
- # Nios II Processor
- ® Nios V/c Compact Microcontroller Intel FPGA IP
Nios Vg General Purpose Processor Intel FPGA IP
Mios Vfm Microcontroller Intel FPGA [P

L L

.

New... Edit... e Add...

3. Expand the Processors and Peripherals and the Embedded Processors branches. Under
Embedded Processors double-click on the Nios V/m Processor Intel FPGA IP.
4. This will open the Nios V/m Configuration page. We will keep the defaults for now. Click

Finish.
- l:ﬂ
iSystem: NIOSY  Path: intel_niosv_m_0
Nios V/m Microcontroller Intel FPGA IP =
intel_niosv_m e
- Example Designs |

For available Nios V/m Example Designs, please visit the Intel Design Store

Link - hitps:/jfwww.intel.com/content/www/us/en/supper t/programmable /fsuppor t-resources/design-examples,design-store. himl

[~ Debug
(@ Enable Debug

() Enable Reset from Debug Madule

[ Use Reset Request |
() Add Reset Request Interface

[~ vectors |
Reset Agent: | absolute ™

Reset Offset: |gxpooooooo

|~ cru

When pipelining is enabled, IPC is higher at the cost of more area and lower frequency.

@ Enable Pipelining in CPU

[~ Ecc

() Enable Error Detection & Status Reporting

5. Now, let's add the RAM IP block. In the IP Catalog enter RAM in the search box.
6. Double-click on On-chip Memory (RAM or ROM) in the Intel FPGA IP.
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™ Ip Catalog 5% -0 E
\ RAM X K&

Project ”
i '.Mg-wCamponmf,..

Library

(=)-Basic Functions
[=+-0n Chip Memory

ESN On-Chip Memary (RAM or ROM) Intel FPGA IP
=-DsP

EH-Video and Image Processing

i ® Frame Buffer II (4 Ready) Intel FPGA TP
E-Memary Interfaces and Controllers
EI Memory Interfaces with AltMemPHY

EI Memary Interfaces with UniPHY

i ® DDR2 SDRAM Controller with UniPHY Intel FPGA IP
- ® DDR3 SDRAM Controller with UniPHY Intel FPGA IP
® LPDDR2 SDRAM Controller with UniPHY Intel FPGA IF

...... -
—Y
[=l-University Program
E-Clock w
< >
New... | Edit... = Add...

7. The configuration page will appear. Change the Total memory size to 102375. This is
819,000 bits which is about have the available memory.

[~ Size
Enable different width for Dual-port access
Slave 51 Data width: 77
Total memory size: 102375 bytes
Minimize memory block usage (may impact fmax)

Intel Max 10 Part Logic Elements Maximum Maximum User I/O
Number Embedded Memory Count
10M02 2000 108 Kbits 246
10M04 4000 189 Kbits 246
10M08 8000 378 Kbits 250
10M16 16000 549 Kbits 320
10M25 25000 675 Kbits 360
10M40 40000 1.26 Mbits 500
10M50 50000 1.638 Mbits 500

8. Uncheck the box for “Initialize memory content”, and click Finish.
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|"’ Memory initialization

[] Initialize memory content

Enable non-default initialization file

Type the filename {e.q: my_ram.hex) or select the hex file using the file browser

ser created initialization file: onchip_mem.hex

Enable Partial Reconfiguration Initizlization Mode

[ Enable In-System Memory Content Editor feature
Instance ID: MOME

9. Inthe IP Catalog search, enter pio.
10. Double-click on the “PIO (Parallel I/O) Intel FPGA IP”.

4, PIO x £
Project

W New Component...

E!--Systern

I nicsvgpio

Library

- Interface Protocols

. [-PCI Express

EI--QS‘(S Example Designs
b

él--Processors and Peripherals
=-Peripherals
S W10 (Parallel I/0) Intel FRGA IP

11. This GPIO block will be used for the LEDs.
a. Setthe Width to 5
b. Set the Direction to Output
c. Set the Output port Reset Value to 0x0000000000000015.

& PIO (Parallel I/0) Intel FPGA IP - pia_0 b4
m PIO (Parallel 1/0) Intel FPGA IP
Megocers  2ItE7a_avalon_pio Documentation
' M e 1\
(] show signals Width (1-32 bits): 5
Direction:
i () Bidir
(O Input
S| () Inout
et
£ et © Output

il |

xternal_connection
pExternal_conneeton e onaut

Output Port Reset Value: |0,000000000000015

[~ Output Register
[ Enable individual bit setting/dearing

altera_avalon_pio

[~ Edge capture register |

Synchronously capture

Edge Type: RISING
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12. Click Finish.

13. In the System Contents tab, change the name of the pio_0 to leds.
14. In the Export column, double click on the line for “external_conenction.

15. Enter leds04.

resetl Reset Input [clk1]
[ ] = leds P10 (Parallel 1/0) Intel FPGA TP
dk Clock Input unconnecte
reset Reset Input [clk]
sl Avalon Memory Mapped Slave [clk]

external_connection

Conduit

16. Double-click on the “PI1O (Parallel 1/0) Intel FPGA IP”.
17. This GPIO block will be used for the single button interrtupt.

a. Setthe Width to 1
b. Set the Direction to Input
c. Check the box next to “Synchornously capture”
d. Setthe Edge Type to RISING
e. Check the box next to Generate IRQ
f. Setthe IRQ type to EDGE.
i #= PIO (Parallel 1/0) Intel FPGA IP - pio_0
“ PIO (Parallel I/Q) Intel FPGA IP
Mogatars’ altera_avalon_pia
| oD [~ Basic Settings
(C) Show signals Width (1-32 bits): 1
HieL Direction: ) Bidir
© Input
S intermupt ) nout
et et ) Cutput
I I Output Port Reset Value: |gxn000000000000000
sdernal_connection -
[~ Output Register
ahera_aval Enable individual bit setting/dearing
\' Edge capture register
@ synchronously capture
Edge Type: RISING
() Enable bit-dearing for edge capture register
[~ Interrupt
B Generate IRQ
IRQ Type: EDGE
Lewel: Interrupt CPU when any unmasked 1/O pin is logic true
Edge: Interrupt CPU when any unmasked bit in the edge-capture
register is logic true, Available when synchronous capture is enabled
|~ Test bench wiring
([C) Hardwire PIO inputs in test bench
Drive inputs to field.: 0x0000000000000000
18. Click Finish.

19. In the System Contents tab, change the name of the pio_0 to button1int.
20. In the Export column, double click on the line for “external_conenction”.

21. Enter button1.

(] E buttonlint PIO {Parallel I/0) Intel FPGA IP
dk Clock Input unconnec
reset Reset Input [clk]

si Avalon Memory Mapped Slave [ck]

external_connection

Conduit

irg Interrupt Sender [clk]

22. In the IP Catalog search, enter uart.

Copyright © 2026 Annabooks, LLC. All rights reserved

Intel is a registered trademarks of Intel Corporation

Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera
All other copyrighted, registered, and trademarked material remains the property of the respective owners.

7



Rev 1

AAnnabgooks-

23. Double-click on the JTAG UART Intel FPGA IP.

% Ip Catalog 5% - |

4, uart & q

Project
Ll New Component...
Library
- Interface Protocols
. [-Serial
----- # 15550 Compatible UART Intel FPGA IP
----- .
P e ® |JART (R5-232 Serial Port) Intel FPGA IP
Iél--l_.lniversity Program
E--Cnmmunicatinns
----- ® IrDA UART
----- ® R5232UART

Mew. .. Edit... = Add...

T il

24. A configuration page will appear. There are no changes to be made. Click Finish.

25. In the IP Catalog search, enter the system ID.
26. Double-click on the System ID Peripheral Intel FPGA IP.
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™ P Catalog  F

- 3

L, 5Yys X #

P_ruject
L.l New Component...

Library
I_f_l--Basil: Functions
E}--Simulaﬁon; Debug and Verification
EI--DEI::ug and Performance
‘. ® Intel FPGA In-System Sources & Probes
o ® SLD Hub Controller System

[=l-Processors and Peripherals
E}--H_ard Processor Systems

I';'l--Uljiversity Program
E}--Cl_l.‘:dc

System ID Peripheral Intel FPGA IP
- @ Trace System

i @ System and SDRAM Clocks for DE-series Boards

27. A configuration page will appear. There are no changes to be made. Click Finish.

- o

Address Map & ‘ Interconnect Requirements &5 ‘
= & . System: niosvgpio  Path: button lint.external _connection
+ Use  Connections Name Description Export Clock
% = B dko Clock Source
*x (=S dk_in Clock Input clkc exported
=] =% ck_in_reset Reset Input reset
dk Clock Output dk_0
= clk_reset Reset Qutput
- [] = DQ intel_niosw_m_0  |Nios V/m Microcontroller Intel FPGA IP
v ck Clock Input unconnected
¥ reset Reset Input [clk]
platform_irg_rx Interrupt Receiver [clk]
timer_sw_agent Avalon Memary Mapped Slave [clk]
instruction_manager AXT4Lite Master [clk]
data_manager AXT4Lite Master [clk]
dm_agent Avalon Memory Mapped Slave [clk]
[] E onchip_memory2 0 |On-Chip Memory (RAM or ROM) Intel ...
dk1 Clock Input unconnected
s1 Awvalon Memory Mapped Slave [clle1]
resetl Reset Input [clk1]
[] B leds PIO (Parallel I/0) Intel FPGA TP
dk Clock Input wnconnected
reset Reset Input [clk]
51 Avalon Memory Mapped Slave [clk]
L=t external_connection Conduit leds04
[] E buttonlint PIO (Parallel I/0) Intel FPGA IP
dk Clock Input unconnected
reset Reset Input [clk]
51 Avalon Memory Mapped Slave [clk]
Conduit
irq Interrupt Sender [clk]
[ -] B jtag_uvart_0 JTAG UART Intel FPGA IP
dke Clock Input wunconnected
reset Reset Input [clk]
avalon_jtag_slave Awvalon Memory Mapped Slave [clk]
irg Interrupt Sender [clk]
[-] B sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk Clock Input wunconnected
reset Reset Input [clk]
control_slave Awvalon Memory Mapped Slave [clk]
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28. Now, we need to wire the IP blocks together. First, wire all the clk lines together by clicking
on the dots for all IP blocks.

nderessMap 7% | Intercornect Reaurements % | -=c

= » W4l System:niosvgpio Path: sysid_gsys_0.dk
* |use  connections Hame Desaription Export Clock Base End
2 B B dk_o |dock Source
X (=5 dk_in Clock Input ok exported
B (=8| ck_in_reset Reset Input reset
P ok Clack Output ck_0
= ok _reset Reset Output
“ '3 EI 05 intel_niosv_m_0  Nios V/m Microcontroller Intel FPGA TP
w7 =13 (Clock Input clk_0
b 4 reset Reset Input [chk]
platform_irg_rx Interrupt Receiver [ck] IRQ Of
timer_sw_agent \Avalon Memory Mapped Slave [ck] 0x0001_D00D  |0x0001_003f
instruction_manager  |AXI4Lite Master [ck]
data_manager \AXT4Lite Master [dk]
dm_agent \Avalon Memary Mapped Slave [ck] 0x0000_0000 |0x0000_££££
-] B onchip_memory2_0 On-Chip Memory (RAM or ROM) Intel ...
it Clock Input dk_0
s1 \walon Memory Mapped Slave [ck1]
resetl Reset Input [ck1]
-] B leds PIO (Parallel 1/0) Intel FPGA TP
ok Clock Input dk_o
reset Reset Input [ck]
s1 Awvalon Memory Mapped Slave [kl
o external_connection  |Conduit leds04
-] B buttonlint PIO (Parallel 1/0) Intel FPGA TP
dk Clock Input dk_0
reset Reset Input [clk]
s1 awvalon Memory Mapped Slave [k
< external_connection  (Conduit button1
i Interrupt Sender [ck]
[ ] B jtag_uart_0 ITAG UART Intel FPGA TP
ok Clock Input clk_0
reset Reset Input [ck]
avalon_jtag_slave avalon Memary Mapped Slave [ck]
irg Interrupt Sender [dk]
[] Bl sysid_gsys 0 System ID Peripheral Intel FPGA IP
Clock Input Double-dick to export
reset Reset Input [chk]
control_slave awvalon Memory Mapped Slave [ck]

29. Next, connect all the reset lines together by clicking on the dots for all IP blocks.
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_ Address Map 3’3| Interconnect Requirements &3

+
1
o,
n

X & ' System: niosvgpio  Path: sysid_gsys_0.reset
# |Use  Connections Name Description Export Clock Base End
‘ ] B ck 0 Clock Source
* C— dk_in Clock Input ck exported
=) (s dk_in_reset Resget Input reset
— dk Clock Qutput dk_0
= pr— dk_reset Reget Output
-~ ] [ 1 intel_niosv_m_0  |Nios V/m Microcontroller Intel FPGA IP
v dk Clock Input iclk_o
¥ reset Reset Input [clk]
platform_irg_rx Interrupt Receiver [chk] IRQ O
timer_sw_agent Avalon Memory Mapped Slave [clk] 0x0001_ 0000 [0=0001_O003£
instruction_manager AXI4Lite Master [clk]
data_manager AXI4Lite Master [clk]
dm_agent Avalon Memory Mapped Slave [clk] 0x0000_0000 |0x0000_££££
] = onchip_memory2_0 |On-Chip Memary (RAM or ROM) Intel ...
dki Clock Input clk_0
=1 Avalon Memory Mapped Slave [clk1]
resetl Reset Input [clk1]
[ ] 2 leds PIO (Parallel 1/0) Intel FPGA TP
dk Clock Input iclk_0
reset Reset Input [clk]
g1 Avalon Memory Mapped Slave [clk]
£ external_connection Conduit leds0D4
] = buttonlint PIO (Parallel I/0) Intel FPGA IF
dk Clock Input clk_0
reset Reset Input [clk]
=1 Avalon Memory Mapped Slave [clk]
T external_connection Conduit button1
irg Interrupt Sender [clk]
2 B jtag_uart_0 JTAG UART Intel FPGA IP
dk Clock Input iclk_o
reset Reset Input [clk]
avalon_jtag_slave Avalon Memory Mapped Slave [clk]
irg Interrupt Sender [clk]
[ ] B sysid_gsys_0 System ID Peripheral Intel FPGA TP
dk Clock Input iclk_0
Reset Input Double-dlick to export
control_slave Avalon Memory Mapped Slave [clk]

30. The memory lines have to be connected together. Connected the Instruction_manager and
data_manager to all other items in the design.
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_ Address Map 33| Interconnect Requirements &2

= & W System:nriosvgpio  Path: sysid_gsys_0.control_slave
F |use  conmections Name Description Expart Clock Base End
L) ] = ck_o Clock Source
X C— ck_in Clock Input iclk exported
= C dk_in_reset Reset Input reset
. ——¢ dk Clock Qutput dk_0
= — ck_reset Reset Qutput
- [ ] = IQ intel_niosv_m_0  |Nios V/m Microcontroller Intel FPGA IP
v ck Clock Input iclk_0
¥ reset Reset Input [clk]
platform_irg_rx Interrupt Receiver [clk] IRQ O
timer_sw_agent Avalon Memory Mapped Slave [clk] 0x0001_0000 0x0001_003£
!E instruction_manager AXT4Lite Master [ck]
data_manager AXI4Lite Master [clk]
dm_agent Avalon Memary Mapped Slave [clk] 0x0000_0000 |0x0000_££££
(] B onchip_memory2_0 |On-Chip Memory (RAM or ROM) Intel ...
dk1 Clock Input iclk_0
s1 Avalon Memary Mapped Slave [cki] 0x0000_0000 |0x0001_3fe€
resetl Reszet Input [clk1]
] B leds PIO (Parallel If0) Intel FPGA IP
dk Clock Input iclk_o
resat Reszet Input [clk]
si Avalon Memary Mapped Slave [clk] 0x0000_0000  |0x0000_000£
< external_connection Conduit leds0a
a E buttonlint P10 (Parallel IfC) Intel FPGA IP
ck Clock Input clk_0
reset Reszet Input [clk]
sl Avalon Memory Mapped Slave [ck] 0x0000_0000 0x0000_000£
< external_connection Conduit button1
irg Interrupt Sender [clk]
[] = jtag_uvart 0 ITAG UART Intel FPGA IP
dk Clock Input iclk_o
resat Reszet Input [clk]
avalon_jtag_slave Avalon Memary Mapped Slave [clk] 0x0000_0000  |0x0000_0007
irg Interrupt Sender [clk]
a B sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk Clock Input iclk_o
Reset Input [clk]
Avalon Memory Mappe: [ck] 0x0000_0000

31. Finally, connect the jtaq_uart and button1int irq lines to the intel_niosv_m_0.
32. If you scroll to the right, the irgs are given a default value.
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Address Map &2 | Interconnect Requirements £
= & W System:niosvgpio Path: jtag_uart_0.irg
* |Use  connections MName Description Export Clock Base End IRQ
% s B dk_o (Clock Source
*x (=S dk_in Clock Input clk exported
(=i [m dk_in_reset Reset Input reset
— ck (Clock Output dk_0o
= —_— dk_reset Reset Cutput
- [] = DQ intel_miosv_m_0  |Nios V/m Microcontraller Intel FPGA IP
v dk Clock Input clk_0
. 4 reset Reset Input [dk]
platform_irq_rx Interrupt Receiver [clk] IRQ O IRQ 15—
timer_sw_agent \Avalon Memory Mapped Slave [clk] 0x0001_0000 0x0001_003£
E instruction_manager \AXI4Lite Master [clk]
data_manager AXI4Lite Master [clk]
dm_agent \avalon Memory Mapped Slave [clk] 0x0000_0000  |0x0000_f££££
] B onchip_memory2 0 |On-Chip Memory (RAM or ROM) Intel ...
dk1 (Clock Input ck_0
51 \Avalon Memory Mapped Slave [ck1] 0x0000_0000 0x0001_gfe€
resetl Reset Input [dk1]
a B leds PIO (Parallel 1/0) Intel FPGA IP
dk (Clock Input clk_0
reset Reset Input [clk]
51 \valon Memory Mapped Slave [clk] 0x0000_0000 020000_000£
= external_connection  [Conduit leds04
] B buttonlint PIO {Parallel 1/0) Intel FPGA IP
dk (Clock Input ck_0
reset Reset Input [clk]
s1 \valon Memory Mapped Slave [clk] 0x0000_0000 0x0000_000£
<A external_connection IConduit buttonl
irg Interrupt Sender [clk] >—h
] B jtag_uart_0 IITAG UART Intel FPGA IP
dk (Clock Input clk_0
reset Reset Input [clk]
avalon_jtag_slave \valon Memory Mapped Slave [clk] 0x0000_0000 0x0000_0007
Interrupt Sender Double-click to export
[] B sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk (Clock Input clk_o
reset Reset Input [clk]
control_slave \valon Memory Mapped Slave [clk] 0x0000_0000 0x0000_0007

33. Let’s assign a base address. From the menu, select System->Assign Base Address. This
will remove a number of errors from the message box.

Platform Designer - unsaved.qsys™ (EAFPGANIntel_Max_10_FPGA_Evaluatis

File Edit System Generate View Tools Help

m Upgrade IP Cores... g

{ Assign Base Addresses a
i i)
— Assign Interrupt Mumbers
Projec - ’ + L
Ll Assign Customn Instruction Opcodes 3
Library Create Global Reset Network b4
E..Bag: E
= Show Systermn With Platform Designer Interconnect =
ry
1 Remove Dangling Connections A l
i . v
3 Import Interface Requirements...
E =W AL SYSTE T X

34. Finally, let's set the reset and exception vector addresses. Double-click on the
intel_niosv_m_0 to open the configuration page.
35. In the Vectors section, change the Reset Agent to onchip_memory2_0.s1
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=i =]
System: niosvgpio  Path: intel_niosv_m_0
Nios V/m Microcontroller
Intel FPGA IP ;
Details

intel_niosv_m

For available Nios V/m Example Designs, please go to: Quart]

https: ffwww.intel. com/contentfwww fusfen fsuppor t/program

[~ Debug
@ Enable Debug

() Enable Reset from Debug Madule

|~ use Reset
(] Add Reset Request Interface

|' Traps, E i and Interrupts
Reset Agent: onchip_memory2_0.51 “
Reset Vector Offset: |gynonoooon
Interrupt Mode: Direct

[~ CPU Archi

When pipelining is enabled, you benefit from higher instructi

When pipelining is disabled, you benefit from lower area and

36. Save the design as niosvgpio.gsys.

37. Once the save has been completed, click Close.

38. Click on Generate HDL...

39. A dialog appears, keep the defaults and click the Generate button.

40. The generate process kicks off. The processes should succeed with warnings, click Close.

A A @

@ Info: rsp_mux: “mm_interconnect_0" instantiated altera_merlin_multiplexer “rsp_m
@ Info: Reusing file E:/FPGA/Intel_Max_10M50_Evaluation_Kit/niosv_gpio/niosvgpio/
@ Info: rep_mux_002: "mm_interconnect_0" instantiated altera_merlin_multiplexer "r
@ Info: Reusing file E:/FPGA/Intel_Max_10M50_Evaluation_Kit/niosv_gpio/niosvgpio/
@ Info: avalon_st_adapter: "'mm_interconnect_0"instantiated altera_avalon_st_adap
@ Info: miosv_reset_controller: "hart” instantiated intel_niosv_m_unit "niosv_reset_co

@ Info: error_adapter_0: "avalon_st_adapter” instantiated error_adapter "error_adap
@ Info: miosvgpio: Done “niosvgpio” with 34 modules, 83 flles

@ Info: gsys-generate succeeded. |
@ Info: Finished: Create HDL design files for synthesis

*, Generate: completed with warnings.

41. Click Finish to close the design.

42. Quartus then reminds you to add the new design to the project. Click Ok.
43. In the Project Navigator, click on the drop-down and select Files.

44. Right-Click on Files and select Add/Remove Files in Project.
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Project Mavigator @ Files * O 0E =

& File-
_'i+ Add/Remove Files in Project...

45. A Settings — NIOSVCPU page appears with Files on the left highlighted. Click the three
dots, browse button for File name, and navigate to
\niosv_gpio\niosvgpio\synthesis\NIOSV_Example\NIOSV\synthesis folder.

46. Click on niosvgpio.qip file and click open

Mame
submodules
D niosvgpic.gip

D nicsvgpio.w

47. Click OK to close the Settings - NIOSVCPU page. The qip file is added to the Project
navigator list. Underneath are all the Verilog files that were generated by Platform Builder.

Project Navigator E Files ~ Q& &
Files =

v E niosvgpio/synthesis/niosvgpio.qip

@ niasvgpiofsynthesis/niosvgpio.v

H® niosvgpio/synthesis/submodules/altera_reset_controllery

EF niosvgpio/synthesis/submaodulesfaltera_reset_synchronizer.v

H® niosvgpio/synthesis/submadules/altera_reset_controllersdc

BB niosvgpio/synthesis/submadules/niosvgpio_irg_mapper.sv

@ niosvgpiofsynthesis/submaodules/niosvgpio_mm_interconnect_0O.w

BH niosvgpio/synthesis/submadules/niosvgpio_mm_interconnect_0_avalon_st_adapter.v

@ niasvgpio/synthesis/submodules/niosvgpio_mm_interconnect_0_avalon_st_adapter_error|

H® niosvgpio/synthesis/submadules/niosvgpio_mm_interconnect_0_rsp_mux_002.sv

BB niosvgpio/synthesis/submodules/altera_merlin_arbitrator.sv

H® niosvgpio/synthesis/submadules/niosvgpio_mm_interconnect_0_rsp_mux.sv

BB ninsvenin/sunthesis/submadules ininsvenin mm interconnect 0 rsn demox 006 su =

48. Save the project.

49. Click on Assignments->Device

50. Click the “Device and Pin Options...” button.

51. Change the Configuration mode to “Single Uncompressed Image with Memory Initialization
(512kbits UFM)”.
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&} Device and Pin Options

Category:

Configuration
Programming Files
Unused Pins

Specify the device configuration scheme and the configuration device.

Dual-Purpose Pins Configuration scheme: | Internal Configuration -
Capacitive Loading
Board Trace Model Configuration mode: Single Uncompressed Image with Memory Initialization (512Kbits UFM) -

I/0 Timing

Voltage

Pin Placement

Error Detection CRC

Configuration device

Auto

52. Click Ok.

53. Click Ok again.

54. In the project navigator, right click on NIOSV.qip and select “Set as Top-Level Entity”.

55. In the Task pane on the left, double-click on Fitter (Place & Route) to start the task. The
analysis will take some time, and it should succeed in the end. This step helps to diagnose
any errors and finds the Node Names for the pin assignments in the next step.

56. Once the process completes, the pin assignments need to be set. From the menu select

#
Assignments->Pin Planner or click on the = icon from the toolbar. The analysis that
was just run populated the Node Name list at the bottom of the Pin Planner dialog.
%) | Named:|* * |%» | Edit
Node Name Direction Location 1/0 Bank VREF Group Fitter Location I/ Standard Reserved Current Strength Slew Rate
i i altera_reserved_tck Input PIN_G2 2.5 V (default) 12mA (default)
- 2ltera_reserved_tdi Input PIN_L& 2.5 V (default) 12mA (default)
% altera_reserved_tdo Output PIN_MS 2.5V (default) 12mA [default) 2 [default)
i altera_reserved tms | Input PIN_H2 2.5 V (default) 12mA (default)
- Dutton?_export Input PIN_E11 2.5V (default) 12mA (default)
i“‘ cli_clk Input PIN_Ma 2.5V (default) 12mA [default)
S ledso4 export[4] Output PIN_E10 2.5V (default) 12mA (default) | 2 (default)
i ledsD4_export[3] Output PIN_E9 2.5V (default) 12mA (default) 2 [default)
S leds04_expori[2] Output PIN_C7 2.5V (default) 12mA (default) | 2 (default)
i leds04_export[1] Output PIN_D7 2.5V (default) 12mA (default) 2 [default)
% leds04_export[0] Output PIN_C8 2.5V (default) 12mA [default) 2 [default)
i reset reset n Input PIN_M2 2.5 V (default) 12mA (default)

<<new node>>

ns

57. Using the board schematic, locate the pins for the button S1, 50Mhz clock, User LEDS,
JTAG, and reset. Set the Location values and I/O Standard for the MAX 10 — 10M50
Evaluation Board as follows:

Node Name Location 1/0 Standard
altera_reserved tck PIN_G2 2.5V Schmitt Trigger
altera_reserved_tdi PIN L4 2.5V Schmitt Trigger
altera_reserved tdo PIN_ M5 25V
altera_reserved _tms PIN H2 2.5V Schmitt Trigger
button1_export PIN R20 1.2V
clk clk PIN_J10 3.3-VLVCMOS
leds04 export[4] PIN_C7 3.3-VLVTTL
leds04 export[3] PIN_D5 3.3-VLVTTL
leds04 export[2] PIN_C5 3.3-VLVTTL
leds04_export[1] PIN_C4 3.3-V LVTTL
leds04_export[0] PIN_C3 3.3-V LVTTL
reset reset n PIN D9 3.3-V LVTTL
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3 Named: * = |«»|Edit

] Node Name Direction Location 1/O Bank VREF Group  FitterLocation |/ Standard ~ Reserved Current Strength  Slew Rate Differential Pair  Strict Preservatio
& sltera_reserved tck  Input PIN_G2 1B B1_NO PIN_G2 2.5V Sc.. Trigger 12maA (default)
& altera_reserved tdi  Input PIN_L4 1B B1_NO PIN_L4 2.5V sc.. Trigger 12mA (default)
s altera reserved tdo  Output FIN_M5 1B B1_NO PIN_M5 2.5 v (default) 12mA (default) | 2 (default)
i altera reserved tms  Input PIN_H2 1B B1_NO PIN_H2 25V Sc. Trigger 12maA (default)
& button1_export Input PIN_R20 5 B5_NO PIN_E11 12v 12mA (default)
& clic_clc Input PIN_J10 8 B8_NO PIN_M8. 3.3-V LVEMOS 2maA (default)
s leds0D4_export[4] Output FIN_C7 8 B8_NO PIN_E10 3.3-V LVTTL 8mA (default) 2 (defaulf)
“a leds04_export{3] Output PIN_D5 8 B8_NO PIN_E9 3.3-V LVTTL 8mA (default) 2 (default)
% leds04 export[2] Output PIN_C5 8 B8 _NO PIN C7 3.3-VLVTTL 8mA (default) 2 (default)
S leds04_export{1] Output PIN_C4 8 B3_NO PIN_D7 3.3-VLVTTL 8mA (default) 2 (default)
% ledsD4_export[0] Output PIN_C3 8 B8_NO PIN_C8. 3.3-VLVTTL 8mA (default) 2 (default)
L reset reset n Input FIN_DS 8 B8_NO PIN_M9 3.3-V LVTTL 8mA (default)

<<new node>>

58. Close the Pin Planner when finished.
59. Save the project.

1.1.3 Add Design Constraints File

1. From the menu in Quartus, select File->New-> Synopsys Design Constraings File
2. Click Ok
3. Add the following:

create_clock -period "50Mhz" -name clk_50MHz clk_clk

derive_pll_clocks -create_base_clocks
derive_clock_uncertainty

set_false_path -from [get_ports reset_reset_n]
set_false_path -from [get_ports altera_reserved®]
set_false_path -from * -to [get_ports altera_reserved_tdo]

set_false_path -from * -to [get_ports leds04*]
set_false_path -from [get_ports button1*]

4. Save the file as niosvgpio.sdc

1.1.4 Compile the Project
The final step is to compile the design

1. Inthe Task pane, right-click on Compile and Design and select Start from the context menu,

or you can click on the symbol in the toolbar. The compile should complete
successfully.
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®, <<Filter
Flow Status

Quartus Prime Version

Successful - Mon Sep 121:00:24 2025
24.1std.0 Build 1077 03/04/2025 SC Lite Edition

Revision Mame niosvgpio

Top-level Entity Name niosvgpio

Family MAX 10

Device 10M50DAF48416G
Timing Models Final

Total logic elements 5,582 /49,760 (11 %)
Total registers 2995

Total pins a/360(2%)

Total virtual pins ]

Total memory bits 823,744 /1,677,312 (49% )
Embedded Multiplier 9-bit elements 0/288(0%)

Total PLLs 0/4(0%)

UFM blocks 0/1(0%)

ADC blocks 0of2(0%)

1.2 Part 2: Nios V Shell Create BSP and Cmake Application

This section will create the BSP and basic application project, and the following section will be used
to create the application in RiscFree IDE.

—_

From the Start menu, open the Nios V Command Shell.

2. A command window appears. Change directory to C:\altera_lite\25.1std\niosv\bin if the
window doesn’t open to the folder.
3. Enter DIR and hit enter. You will see a number of applications available.

r

Nios V Command Shell (Quart > + | ~

[niosv-shell] C:\Users\SEAN_\AppData\Local\quartus> cd \altera_lite\25.1std\niosv\bin

[niosv-shell] C:\altera_lite\25.1lstd\niosv\bin> dir
Volume in drive C is 0S
Volume Serial Number is 8U©7-T76ED

Directory of C:\altera_lite\25.1std\niosv\bin

12/15/2825
12/15/2825
10/22/20825
10/22/20825
18/22/2825
18/22/20825
10/22/20825
10/22/20825
18/22/20825
12/15/2825
10/22/20825
12/15/2825
18/22/2825
12/15/2825
10/22/20825

PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
:29 PM
18 File(s)
5 Dir(s)

<DIR>
<DIR>

2ug, 832

91,867

2u8, 832

71,571

209, 3u

249, 3uy

209, 3u4

218,112
218,112

218,112

elf2flash.exe
elf2flash. jar
elf2hex.exe

elf2hex. jar
niosv-app.exe
niosv-bsp-editor.exe
niosv-bsp.exe
niosv-download-files
niosv-download.exe
niosv-shell-files
niosv-shell.exe
niosv-stack-report—files
niosv-stack-report.exe

2,063,470 bytes
1,392,243,388,

416 bytes free

[niosv-shell] C:\altera_lite\25.1std\niosv\bin>

4. Run niosv-bsp-editor.exe
5. The BSP Editor opens up.
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6. From the menu, select File-New BSP...

7. Click on the button with 3 dots for “SOPC Information File name:”

8. Open the niosvgpio.sopcinfo. As the file opens, the file information is read and fills the rest
of the dialog.

m

Hardware
SOPC Information File name:  |E:'\FPGA\Intel_Max_10M50_Evaluation_Kitiniosv_gpioniosvgpio.sopdnfo

CPU name: |intel_niosw_m_0 e
Software
Operating system: | Altera HAL e Version: | default I
@ Use default locations
BSP target directory:  |E:\FPGA\Intel_Max_10M50_Evaluation_Kit\niosv_gpio\software‘hal_bsp
BSP Settings File name:  |3A\Intel_Max_10M50_Evaluation_Kit\niosv_gpioisoftwarethal_bsplsettings.bsp

@ Enable Settings File relative paths

[C) Enable Additional Td script

Additional Td script:

Cancel

9. Keep the default settings. Click Ok.

i BSP Editor - EAFPGAVIntel Max_10M50_Evaluation |

File Edit Tools Help

Main} Software Packages Drivers Linker Script  Enable File Generation  Target BSP Directory

SOPC Information file: ..\ \niosvgpio.sopcinfo
CPU name:  intel_niosv_m_0
Operating system:  Altera HAL Version: | default v
BSP target directory: .\

Bjsciinc:| na
Common

= hal max_file_descriptors 32
e fk_ti
: ?;;;E-;;"Tmr () enable_instruction_related_exceptions_api
Lostdin ([ use_df_walker
+--stdout
H dfl_start_address -
stderr . 1
enable_reduced_device_drivers LG one »
+--enable_sim_optimize
-linker
ble_exit
enable_exception_stack etz e
exception_stack_size - enable_clean_exit
--exception_stack
sxcepton Sk memon.egon.o e T
-make @ enable_c_plus_plus
cflags_debug
cfiags._optimazation (0 enable_lightweight_device_driver_api
--cflags_wamnings log_flags 0
enable_cflag_fstack_protector_stro
~-gnable_cflag_wformat_security sys_clk_timer: intel_niosy_m_0 ~
Advanced )
5 pal timestamp_timer intel_niosy_m_0

--max_fle_descriptors
enable_instruction_relsted_exceptions
-use_dfi_waker

stdin: jtag_uart 0 ~

stdout: jtag_uart 0 ~

Information  Problems Processing

(@ Td message: "Application ELF allowed to contain code at the reset address.”
(@ Setting "hal.linker.allow_code_at_reset” set to "true”,

@ Setting "hal.linker .enable_alt_load" set to “true”.

@ Td message: "The alt_load() fadiity is enabled.”

(@ Setting "hallinker.enable_alt_load_copy_rwdata” set to "rue”,

(@ Td message: "The .rwdata section is copied into RAM by alt_load().”

(@ Default memory regions will not be persisted in BSP Settings File.

(@ Generated file "E:\FPGAVIntel_Max_10MS0_Evaluation_Kitiniosy_gpio\software \hal_bsp\settings.bsp”
(@ nitializing BSP components....

(@ Finished initializing BSP components. Tatal time taken = 2 seconds

(@ Searching for BSP components with category: os_software_element

Generate Exit

10. Under Settings root, uncheck “enable_c_plus_plus’
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File Edit Tocls Help

valuation_Kit\N

Main  Software Packages Drivers Linker Script Enable Fie Generation Target BSP Directory

SOPC Information file:

E:\FPGA\Intel_Max_10_FPGA_Fvaluation_KitiNIOSV_Example\NIOSV.sopcinfo

- enable_exception_stack
exception_stack_size
exception_stack_memory_region_r

@ enable_clean_exit

() enable_runtime_stack_checking

CPURame: intel_niosv_m_0

Operating system:  Altera HAL Version: | default v

BSP target directory: ..\..\..\..\..\..\C:intelFPGA ite\24. 1std\niosv \bin
E] hal
Common .
= hal max_file_descriptors: 32

+-sys_ck_timer
timestamp_timer (] enable_instruction_related_exceptions_api
-stdin () use_dfi_walker
+-stdout
i dfl_stari_address: B
Lostderr S 1
enable_reduced_device_drivers Jog_part none »
:-enable_sim_optimize
inker @ enable_exit

“-use_picolibc
=-make () enable_c_plus_plus
i cflags_debug
.- cflags_optimization () enable_lightweight_device_driver_api
i~ cflags_warmings log_flags 0

Information  Problems Processing

(@ Firished loading BSP section mappings from settings file.

(@ setting "hal.linker.exception_stack_memory_region_name” set to “onchip_memory2_0",

(@ Loading drivers from ensemble report.

(@ WMapped module: “ntel_niosv_m_0" to use the default driver version.

(@ Mapped module: “sysid_gsys_0" to use the default driver version,

(@ Mapped module: “jtag_uart_0” to use the default driver version.

(@ Finished loading drivers from ensemble report.

(@ Loading BSP settings from settings file.

@ Finished loading SOPC Bilder system info file "E:FPGAVIntel_Max_10_FPGA_Evaluation_KtNIOSV_Example NIOSV.sopdnfo”

Generate Exit

11. Click the Generate button.

12. Once the BSP has been generated, click on Exit to close the BSP Editor.

13. Open File Explorer, and navigate to \NIOSV_Example\software folder. You will see what
BSP files were generated.

14. Under \NIOSV_Example\software folder, create a subfolder called “app.”

Mame : Date modified Type Size

drivers 11/15/2023 7:46 PM File folder

HAL 11/15/2023 7:46 PM File folder
[ alt_sys_init.c 11/15/2023 7:46 PM C Source 4 KB
|j CMakelists.bet 11/15/2023 7:46 PM Text Document 6 KB
[ linkerh 11/15/2023 7:46 PM C/C++ Header 3KB
[ tinkerx 11/15/2023 7:46 PM X File 13KB
D memeary.gdb 11/15/2023 7:46 PM GDE File 3KB
[] settings.bsp 11/15/2023 7:46 PM BSP File 41KB
e summary.html 11/15/2023 7:46 PM Microsoft Edge H... 4T KB
[ system.h 11/15/2023 7:46 PM C/C++ Header 12 KB
[ toolchain.cmake 11/15/2023 7:46 PM CMAKE File 2KB

@ New Tl Sort = View
> NIOSV MName : Date modified Type
output_files app File folder
~ software bsp File folder
> app
> bsp
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15. Create a text file called main.c in the \niosv_gpio\software\app folder.
16. In the niosv-shell, change directory to the \niosv_gpio\software\app app folder.
17. Run the following command:

niosv-app -b=../hal_bsp -a=. -s=main.c
18. A CmakelList.txt file gets generated, open the text file in an editor.
cmake_minimum_required(VERSION 3.14)
add_subdirectory(../hal_bsp hal_bsp)

include(../hal_bsp/toolchain.cmake)

project(app)

enable_language(ASM)
enable_language(C)
enable_language(CXX)

add_executable(app.elf)

target_sources(app.elf
PRIVATE
main.c

)

target_include_directories(app.elf
PRIVATE
PUBLIC

)

target_link_libraries(app.elf
PRIVATE
-T "${BspLinkerScript}" -nostdlib
"${ExtraArchiveLibraries}"
-WI,--start-group "${BspLibraryName}" -Ic -Istdc++ -Igcc -Im -WI,--end-group
)

# Create objdump from ELF.
set(objdump app.elf.objdump)
add_custom_command(
OUTPUT "${objdump}"
DEPENDS app.elf
COMMAND "${ToolchainObjdump}" "${ToolchainObjdumpFlags}" app.elf >
"${objdump}"
COMMENT "Creating ${objdump}."
VERBATIM

)
add_custom_target(create-objdump ALL DEPENDS "${objdump}")

# Report space free for stack + heap. Note that the file below is never created
# so the report is always output on build.
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set(stack_report_file app.elf.stack_report)

add_custom_command(
OUTPUT "${stack_report_file}"
DEPENDS app.elf
COMMAND niosv-stack-report -p "${ToolchainPrefix}" app.elf
COMMENT "Reporting memory available for stack + heap in app.elf.”
VERBATIM

)
add_custom_target(niosv-stack-report ALL DEPENDS "${stack_report_file}")

# Generate HEX file(s) from app.elf using elf2hex tool.
# Note : If ECC Full is enabled, width of 39 is set for NiosV TCM. Otherwise, 32.
add_custom_command(

OUTPUT "onchip_memory2_0.hex"

DEPENDS app.elf

COMMAND elf2hex app.elf -o onchip_memory2_0.hex -b 0x00000000 -w 32 -e
0x00018FE6 -r 4

COMMENT "Creating onchip_memory2_0.hex."

VERBATIM

)
add_custom_target(create-hex ALL DEPENDS "onchip_memory2_0.hex")

1.3 Part 3: Write the GPIO-Interrupt Application in RiscFree IDE for Intel
FPGAs

Now, we are ready to write the applications in the RiscFree IDE.

1. Open niosv-shell if not already open.
2. Type the following and hit enter to start RiscFree IDE:

riscfree.exe

Warning: The reason to open RiscFree.exe via niosv-shell is to take advantage of the niosv shell
path settings so the build tools can run the HEX generation convertions. If RiscFree.exe is run
outside the niosv-shell environment, the application will be built, but fail on the HEX conversion.

3. Keep the default work space and click Launch.
4. Click on Create Project or from the menu select File->"Import Nios V CMake project...”

Copyright © 2026 Annabooks, LLC. All rights reserved

Intel is a registered trademarks of Intel Corporation

Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera

All other copyrighted, registered, and trademarked material remains the property of the respective owners.

22



Rev 1

#Annabooks-

Workspace2 - Ashling RiscFree™ IDE

File Edit Source Refactor Mavigate Search Project Run
New Alt+Shift+N > tior
Open File... 1 g

L Open Projects from File System...

Recent Files >

Refresh F5

%

Convert Line Delimiters To >

Import... Import Nios ¥ CMake based project

& |Import Nios V CMake project...
Export...

Properties Alt+Enter

Switch Workspace >
Restart
Exit

5. In the import dialog, click on browser and open the app folder location.
6. Change the project name to gpio_interrupt.

Import

Import Existing Code

Import Nios V CMake based project.

Project name:

gpio_interrupt

Nios V CMake project location:

EAFPGANIntel_Max_10M30_Evaluation_Kit\niosv_gpic\software\app Browse...
Finish Cancel

7. Click Finish.

The system.h file in the \hal_bsp folder contains the defines for the GPIO such as
BUTTON1INT_BASE and LEDS_BASE. These hardware defines are used in the main application.

8. Open the main.c and fill in the following code:

#include "stdio.h"
#include "system.h"
#include "unistd.h"
#include "alt_types.h"
#include <sys/alt_sys_init.h>
#include "sys/alt_stdio.h"
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#include "sys/alt_irqg.h"
#include "altera_avalon_pio_regs.h"

Il Global variable to track interrupt events
volatile int gpio_interrupt_flag = 0;

Il Interrupt Service Routine (ISR) for GPIO
void gpio_isr(void* context) {

volatile int* edge_capture_ptr = (volatile int*)context;

Il Clear the interrupt edge capture register
*edge_capture_ptr
IORD_ALTERA_AVALON_PIO_EDGE_CAP(BUTTON1INT_BASE);
IOWR_ALTERA_AVALON_PIO_EDGE_CAP(BUTTON1INT_BASE, 0);

Il Set the interrupt flag
gpio_interrupt_flag = 1;

printf("GPIO Interrupt Triggered!\n"); //For example only, should don't this normally

}

int main() {
I/l Variable to store edge capture value
volatile int edge_capture = 0;
int in, out;

Il Clear any pending interrupts
IOWR_ALTERA_AVALON_PIO_EDGE_CAP(BUTTON1INT_BASE, 0);

/I Enable interrupts for the GPIO

IOWR_ALTERA_AVALON_PIO_IRQ_MASK(BUTTON1INT_BASE, 0x1);

interrupt for pin 0

I/l Register the ISR
alt_ic_isr_register(BUTTON1INT_IRQ_INTERRUPT_CONTROLLER_ID,
BUTTON1INT_IRQ, gpio_isr, (void*)&edge_capture, 0);

printf("GPIO Interrupt Example Started.\n");

while (1) {

if (gpio_interrupt_flag) {
I/ Handle the interrupt event
gpio_interrupt_flag = 0;
printf("Handling GPIO Interrupt...\n");
in =IORD_ALTERA_AVALON_PIO_DATA(LEDS_BASE);
out =in * Ox1F;
IOWR_ALTERA_AVALON_PIO_DATA(LEDS_BASE, out);

}
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return 0;

}

The application toggles the user LEDs on each press of the button. A global variable is setup as
an interrupt flag. The interrupt flag will be used by the main while-loop to check when the interrupt
has been triggerd. The gpio_isr() handles the interrupt. The isr checks the edge register and clears
the register so other interrupts can be proceed. The interrupt flag is then set and message is printed
to the console.

The main() application creates a variable for the edge capture value, and two other variables that
will be use to read/write to the User LEDs. All intererupts are cleared, the button interrupt is enabled,
the gpio_isr is registered to the button interrupt. After a message is sent that the application has
started, the main while-loop is reached. If the interrupt flag is set, the flag is cleared, a message is
sent to the console, and the LEDs are XOR to toggle between off-on-off-on-off and on-off-on-off-
on.

9. Right-click on app project and select Build Project from the context menu.
10. Near the bottom right, set the console output to CDT Build Console [app].

Bf = &E|AB-m-= 0O

1 CDT Glekal Build Conscle
2 COT Build Console [app]
3 CMake Conscle [app]

4 5cript Pad Console

@ @ M

The build should complete successfully with a app.elf file being created.

1# | Problems J=| Tasks B Console X Epmperties o Search
CDT Build Console [gpio_interrupt]
| 97%] Creating app.elt.objdump.
[ 98%] Reporting memory available for stack + heap in app.elf.
[1ea%] Creating onchip_memory2 @.hex.
TBBmalloc: skip allocation functions replacement in ucrtbase.dll: unknown prologue for function _msize
[1ea%] Built target create-objdump
app.elf
* 34.89 KB - Program size (code + initialized data)
* 6@.82 KB - Free for stack + heap.
[1ea%] Built target create-hex
[1@8%] Built target niosv-stack-report

21:23:44 Build Finished. @ errors, @ warnings. (took 2s5.185ms)

Warning: If you open RiscFree IDE independently of the niosv-shell, an error will appear at the
end. The file was built, but the paths to run the stack report and create HEX files were invalid. You
can always run the niosv-stack-report.exe and elf2hex.exe seperatly.
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B Problems J&| Tasks B Console » [ Properties < Search S@| &1

CDT Global Build Console

| 98%] Creating app.elf.objdump.

[1e8%] Reporting memory available for stack + heap in app.elf.

process_begin: CreateProcess(NULL, niosv-stack-report -p riscv32-unknown-elf- app.elf, ...) failed.
make (e=2): The system cannot find the file specified.

make[2]: *** [(MakeFiles/niosv-stack-report.dir/build.make:73: app.elf.stack report] Error 2
make[1]: *** [(MakeFiles/Makefile2:177: CMakeFiles/niosv-stack-report.dir/all] Error 2

make[1]: *** Waiting for unfinished jobs....

[1ee%] Built target create-cbjdump

make: *** [Makefile:91: all] Error 2

"C:/fintelFPGA_lite/24.1std/riscfree/build_tools/bin/make.exe -j all™ terminated with exit code 2. Build might be incomplete.

14:91:@1 Build Failed. 4 errers, 1 warnings. (took 13s.246ms)

1.4 Part 4: Test the Design and the Application
With the design and application compiled, we can now test the design and application on the board.

1.41 Hardware Setup

The 10M50 Evaluation kit comes with a USB cable with red and black USB connectors. The black
connector is for the JTAG. The red connector is only for power. JTAG communcation can be over
USB or through the 10-PIN JTAG connector. JTAG over USB will be used for this example.

1. Switch 4 on switch block 2 (SW2.4) enables/ diables the USB JTAG. The default mode is
off. Switch SW2.4 to On for USB JTAG.

2. Since this will be powered by USB make sure jumper 11 (J11) has pins 2 and 3 connected.

3. Connect the USB cable to the 10M50 Eveluation kit and the red and black connectors to
your Quartus development system.

4. Open Device Manager, and you should see the Altera USB Blaster Il in the device list. If
the device doesn’t show up makes sure you installed the driver that comes with the kit.

A

File Action View Help
oo T HE =B
v A S

» W Audic inputs and cutputs

> @ Batteries

b} 9 Bluetooth

> O Computer

> Ij Dellinstrumentation

5 wm Diskdrives
> @ Display adapters
> e DVD/CD-ROM drives
> i Firmware
> @) Human Interface Devices
» % Imaging devices
v § JTAG cables
" Altera USB-Blaster || (JTAG interface)
' Altera USB-Blaster || (System Conscle interface)

5 EH Kevboards

1.4.2 Program the Board
We will go back to Quartus and program the board with the design.

1. In Quartus Prime, from the Task pane, right-click on Program Device (Open Programmer)

and select Open from the context menu or click on the i icon on the toolbar.

The Programmer dialog appears, click on the “Hardware Setup” button.

Click the Add hardware button, select the Hardware type, and fill in any remaining
information, and click OK.

wn
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E:/FPGA/Intel_Max_10M50_Eva | - niosvgp a.cdf] = O
Search Intel FPGA (]
aHardware Setup... | |USB-Blasterll [USB-1] Mode: | JTAG - Progress :
Enable real-time ISP to allow background pr- N T T
File
phstart Hardware Settings | JTAG Settings
output_files/niosvgpio...
fin stop put fles/ &P Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.
8 Auto Detect
Delate Currently selected hardware: | USB-Blasterll [USB-1] -
M pdd File Hardware frequency: 24000000 Hz
e Available hardware items
Change File.
]
U S ave File Hardware Server Port Add Hardware...
USE-Blasterll Local USB-1
#* 5 dd Device Remove Hardware
FYTTTTTT)
hup o
T
' Dowr g
u
TOMSODAF
TDO
—

Close

4. An niosvgpio.sof file gets created during the Compile Design flow. The file is automatically
filled in. There is only one FPGA on the board and in the JTAG chain so the file already
has the Program/Configure checkbox checked. Click the Start button to program the board.
The process takes a few seconds and shows that the task was completed successfully.

3 Programmer - Ei/FPGA/Intel_Max_10M50_Evaluation_Kit/niosv_gpio/niosvgpio - niosvgpio - [niosvgpio.cdf]

File Edit View Processing Tools Window Help h Intel EPGA e
; Hardware Setup... | |[BE=g=RE N (V)] Mode: | JTAG - Progress 100% (Successful) l
Enable real-time ISP to allow background programming when available
m File Device Checksum Usercode Program/ = Verify = Blank- Examir
- lstart Configure Check
i Stop output_files/niosvgpio.sof 10MS0DAF484 0DEBADZ4  DDBBAD94 v
4 Auto Detect
Delete
B Add File...
& Change File...
1 b
il save File
* Add Device..
TTTTTTTIT
el Up H H
TDI H =
"l Down b 4 H
H H
H =
LLILLLIITT]
T0M50DAF484
TDO
4
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The 5 user leds get set to off-on-off-on-off per the preconfiguration performed in Platform Designer.

Notice that there is no time constraint dialog box popping up. The Nios V is free and doesn’t
required a paid license.

1.4.3 Debug the Application
Now, we go back to the RiscFree IDE to download and debug the applicaiton

With the JTAG cable connected, in RiscFree IDE, right click on the gpio_interrupt project
in Project Explorer.

2. Select Debug AS->Debug Configurations...

3. Click on Ashling RISC-V hardware Debugging

In the Main tab, you should see the project pointing to the app.elf file.

7]

Create, manage, and run configurations

€9 [Debugger]: Invalid Target Configuration @

E] R BV~

type filter text

Mame: gpio_interrupt Default

[] Main| %5 Debugger | + Startup | 88 OS Awareness | & Source| [] Common | &, SVD Path
[E] Ashling Arm Hardware Debugging

[ Ashling Heterogeneous Multicore He
[&] Ashling QEMU Simulator Debugging gpio_interrupt

Project:

Browse.
« [£] Ashling RISC-V Hardware Debugging || | ¢/Ces Application:

O o e EAFPGAVIntel_Max_10MS0_Evaluation_Kit\niosv_gpic\scftware\app\build\Default\app.cif
[E] C/C++ Application

C/C++ Attach to Application Variables... Search Project... Browse...

pp )

[E] C/Cr+ Remote Application Build (ff required) before launching

EASE Script

[£] GDB Hardware Debugging Build Configuration: Select Automatically v
[&] GDB Open0CD Debugging

Click on Debugger tab.

Set the Debug probe to the debug probe connected to the board.
Set the JTAG frequency to 16 MHz

Click on the “Auto-detect Scan Chain”. The Devcie/TAP selection should be filed in with
the 10M08 FPGA and the Core selection should be the Nios V.

®No O

]

| Create, manage, and run configurations )
i .

8 X |2 7~ Name: gpio,_interrupt Default
type filter text

[5] Main [%5 Debugger| b= Startup| 5 05 Awareness| & Source| [[] Commen| %, SVD Path
[£] Ashling Arm Hardware Debugging Debug Probe Configuration
[& Ashling Heterogeneous Multicore He
[£] Ashling QEMU Simulator Debugging Debug probe  USB-Blasterll [USB-1] hd I

Transport type ITAG
~ [] Ashling RISC-V Hardware Debugging

JTAG frequency 16 v MHz
[ gpic_interrupt Default AR
[E] ¢/C++ Application Target Configuration
[T] C/C++ Attach to Application
[E] C/C++ Remote Application
EASE Script Auto-detect Scan Chain
[£] GDB Hardware Debugging
[5] GDB OpenOCD Debugging Device/TAP selection 10MS0DA(ES)/10MS0DC (0x ~ Core selection Nios V (0x08936E00) v

£ Launch Group
©9 Simics Attach to Session

[0 De not halt the target
©9 Simics Session

(B Reset mstatus CSR register

(D lssue TAP reset

GDB Server Setup

Additional command-line arguments.

GDE Client Setup

Executable name: ${eclipse_home}/../toolchain/riscv32-unk If/in/

If-gdbexe  Browse.. Variables..

Custom instruction file: S{eclipse_home}/../debugger/gdbserver-riscv/niosv_custom_instrxml Browse...  Variables.

Other options:

Commands:

9. Click Apply
10. Click Debug. The application will download and stop at the first line in Main().
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Workspace2 - gpio_interrupt/main.c - Ashling RiscFrae™ IDE

File Edit Source Refactor Nevigate Search Project Run Window Linux Help

jmild | & & New Connection... LA AN PR =R R I i P N S o | Si%-0-Qu-i® & - - - & -
45 Debug X Project Explorer = i § = B [§mainc X [g systemh =
f Debug X[ Project Bxp! g g sy:
~ [E] gpio_interrupt Default [Ashling RISC-V Hardware Debugging]
v B appelf Global variable to track interrupt events
~ f# Thread #1 [TAP 1 (Hart 0)] 1 (Suspended : Breakpoint) volatile int gplo_interrupt flag = 6;
g — s e // Interrupt Service Routine (ISR) for GPIO
W ash-riscu-gdb-server.ere = void gpio_isr (va:\d‘ context) {

W riscv32-unknown-eff-gdb.exe
volatile int* edge_capture_ptr = (volatile int*)context;

lear the inter up dg
Edge capture_ptr = )_EDGE_CAP (BUTTONLINT_BASE);
TOWR_ALTERA_AVALON_] PIO EDGE CAP(EUTTONiINT EASE @);

t the interrupt
gpw mterr‘upt flag = 1

printf("GPIO Interrupt Triggered!\n"); //For example only, should don't this normally

5 - int main() {

Variable to store edge capture value
volatile int edge_capture - 8
int in, out;

lear any pending interrup
TOMR_ALTERA_AVALON_PIO_EDGE (Av(auTmmmr BASE, 0);

Enable interrupts for the GPIO
TOWR_ALTERA_AVALON_PTO_IRQ_MASK(BUTTONLINT_BASE, @x1); // Enable interrupt for pin @

Register the ISR
alt_ic_isr_register(BUTTON1INT_IRQ_INTERRUPT_CONTROLLER_ID, BUTTONIINT_IRQ, gpio_isr, (void*)8edge_captu:

printf("GPIO Interrupt Example Started.\n");

uhile (1) {
£ (gpio_interrupt flag) {
7/ vandle the Interrupt event
gpio_interrupt_fla
printf("Handling GPIO Interrupt...\n");
in = TORD_ALTERA_AVALON_PIO_DATA(LEDS_BASE);
ut = in * @xiF;

11. Open niosv-shell.l
12. Run the following command to start the terminal application: juart-terminal --
cable="USB-BlasterII [USB-1]"

Note: The arguments specify which cable to use as the JTAG console connection. Run juart-
rterminal -h to get a list of other command line arguments available.

niosv-shell - juart-terminal - X + v O x

[niosv-shell] C:\intelFPGA_lite\24.1std\niosv\bin> juart-terminal --cable="USB-BlasterII [USB-1]"
juart-terminal: connected to hardware target using JTAG UART on cable

juart-terminal: "USB-BlasterII [USB-1]", device 1, instance @

juart-terminal: (Use the IDE stop button or Ctrl-C to terminate)

13. In RiscFree IDE, step throught the code. You will see the messages sent to the juart-
terminal.

niosv-shell - juart-terminal -- X + | - = o ><

[niosv-shell] C:\intelFPGA_lite\24.1lstd\niosv\bin> juart-terminal --cable="USB-BlasterII [USB-1]"
juart-terminal: connected to hardware target using JTAG UART on cable

juart—terminal: "USB-BlasterII [USB-1]", device 1, instance @

juart-terminal: (Use the IDE stop button or Ctrl-C to terminate)

GPIO Interrupt Example Started.|

14. Click Continue to let the program run.
15. Press switch button 1 on the board. The LEDs should toggle to on-off-on-off-on, and
messages aboth the interrupt being serviced should appear on the juart terminal.
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niosv-shell - juart-terminal -- X

[niosv-shell] C:\intelFPGA_lite\2u.1std\niosv\bin> juart-terminal ——cable="USB-BlasterII [USB-1]"
juart—terminal: connected to hardware target using JTAG UART on cable
juart-terminal: "USB-BlasterII [USB-1]", device 1, instance @

juart-terminal: (Use the IDE stop button or Ctrl-C to terminate)

GPIO Interrupt Example Started.
GPIO Interrupt Triggered!
Handling GPIO Interrupt...

16. Stop debugging when finished.

1.5 Summary: Building Up a Custom Microcontroller

The 10M50 Evaluaiton Kit offers more on chip RAM to support Nios V applications. The exercise
demonstrated GPIO read, write, and interrupt handling with Nios V. From here, all the rest of the
microcontroller such as UART, SPI, 12C can be added to create a custom micro controller.

1.6 References
The following references were used for this article:

RISKFree IDE Documentation:
https://www.intel.com/content/www/us/en/docs/programmable/730783/24-2/about-the-ide.html

Video: Debugging the Nios® V Processor Using the RiscFree* IDE for Intel® FPGAs
Video: Build A Soft Core CPU - Part Three - NIOS 1l in Intel FPGA
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